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Abstract: In recent years as the rise of Internet + and geographic information system technology, 
the traditional GIS has a new development space, let a lot of further application of spatial data, 
decision making analysis on the space for us to provide the technical support. In the implementation 
of the national "863" project "corn precision operating systems research and application in the 
process, accumulated the massive spatial data on agriculture, to organize and manage these data, get 
the corresponding knowledge, better management, analysis and decision making, developed" 
WebGIS corn intelligent decision-making system based on Internet + "for application. The main 
contents include: using ArcIMS system to realize the basic operation of network geographic 
information system; Implements the new mode based on tiles splicing ways of network map 
browsing, when pan, in IE will have the effect of image stitching, shorten the waiting time for the 
user psychology, also to avoid the big picture of the large amount of data transmission; The 
visualization of spatial data mining results based on star coordinates is realized. The spatial data 
mining visualization of GIS is realized. The function of buffer analysis and variation chart is 
realized. The decision-making function of fertilization was realized. Combining analytic hierarchy 
process and fuzzy equivalent matrix method, spatial weighted fuzzy clustering algorithm is 
implemented.At the same time, the optimal classification number is obtained by using F distribution. 
By comparison, this method has higher precision and better effect than unweighted algorithm. In 
addition, this method is applied to the comprehensive evaluation of the difference of soil nutrient 
space, which is recognized and praised by experts of the review of agricultural engineering journal. 

1. Introduction 
Due to the spatial differences between corn fields is based on soil, soil nutrient spatial variation 

of the determination of precise fertilization, in order to ensure that farmers adjust measures to local 
conditions of fertilization, meet the need of national industrial structure adjustment of agriculture 
environment.The different space scale data, data in the different periods and different formats of 
data in a unified coordinate system to achieve efficient and orderly and the development of the 
centralized and unified management is the most effective way.Using digital technology to establish 
a new type of modern agricultural management mode, transforming the traditional agriculture to 
modern agriculture, promote the development of circular agriculture has very important practical 
significance [1].Based on this idea, developed a fuzzy Data Mining based on the Visual space of the 
Internet + (Visual Spatial Data Mining, VSDM) and network geographic information system 
(WebGIS) of corn intelligent decision-making system is very necessary, the system could be used 
for agricultural production and management of various departments to provide decision-making 
reference information, provide users targeted scientific fertilizer and spraying guiding effect [2]. 

2. The overall design 
According to the structure of WebGIS and the demand of corn fertilizer decision system, the 
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overall frame of the system is designed as shown in fig.1. 

 
Fig 1  overall functional framework 

3. Database establishment 
(1) spatial database establishment: the spatial database is established mainly by two means: first, 

the paper makes use of the paper map to vectorization; The other is using GPS. 
(2) paper map vectorization: 
Computer configuration: hardware: CPU: PIII or higher, RAM: greater than 256M, HD: > 20G; 

Software: ArcView and ArcMap gis software for ESRI, USA. 
Digital maps: first of all, the 1:50000 or 1:100000 paper map (such as soil map, administrative 

zoning map) scan, will scan in the online edition of TIF or JPG format, 24 true color, 300 dpi 
resolution. Second, the calibration of the electronic map in the ArcMap software, the paper (photo) 
on each major datum and the optional four (up, down, left, right), find the coordinates, if it is the 
earth coordinates (latitude and longitude) needs to be converted to the rectangular plane coordinates. 
The process is as follows: 

Open ArcMap and select the location module Georeforencing, as shown in figure 2. Open to 
locate scan map file in Georeforencing option buttons on the toolbar, find the coordinates of known 
points on the graph, the right name dialog box, enter the rectangular plane coordinates (X to 8 digits, 
Y for seven figures, the coordinates on the graph of insufficient use 0 is lacking, as shown in figure 
3), latitude and longitude position need to generate a standard grid (as shown in figure 4), 
calibration, repeatedly until the error is close to zero. 

     
 Fig2Positioning module selection; Fig3Enter Registration coordinates;    Fig4 Standard grid generation 

Regenerates a grid file after the location of the file output. Select the Rectify in the 
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georeforexample menu... Options (as shown in figure 5), enter the grid size, type and name in the 
pop-up dialog box (see figure 6), and click the OK button to store it. 

 
Fig5 Rectify ... Options 

 
Fig6 Export Raster File dialog box 

Finally, the map vector is vectorized with ArcView software. The process is to open the 
calibrated map in the ArcView and create a new file (point, line, or face file, whose properties and 
layout are table 1). Use the tool shown in figure 7 to vectorize the graph. Note: the boundary (outer 
outline) is usually drawn first when the document is drawn. Then the boundary (outer contour 
polygon) is cut with the drawing of the polygonal cutting tool. After the drawing of the independent 
polygon is finished, we need to separate the two tabula with Subtract Features. [3] 

Table1 New File Types 

 Attribute  layout 

Point files 
 
Line files 
 
The face file 

are defined in data tables such as: residential, 
elevation, text, etc.  
are defined in data tables such as roads, 
railways, linear rivers, etc  
defines the fields for each specialized element 
in the data table. 

by size, shape, and colo 
 
Show different definitions by the thickness, 
shape and color of the line. 
The shape and color of the soil map, the surface 
of the river and other elements 

   
 

After the vectorization, you need to add a property value to it, as shown in figure 7 and figure 8. 

 
Fig7 Add a field option 

 
Fig 8 Setting the field names and types 

Vectoring result:Vectorization maps of the arbor town, nongan county and lishu county were 
established using vectoring method (see Fig. 9, Fig. 10, Fig. 11). 

       
Fig 9 Vector Map of Yushu City gongpengzi; Fig 10 vector map of Nongan ;   Fig 11 vector map of Lishu 
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(3) GPS collection 
The GPS device USES the American Trimble's AgGPS differential GPS station and a set of 

receivers to achieve the accuracy of the sub-meters.Data acquisition software acquisition process in 
U.S. DeltaDataSystem company's Pocket DLog software, the software in the connection of 
handheld computer graphics equipment and global positioning system (GPS), can provide abundant 
data acquisition function [4]. The process of collecting data is as follows: 

Run the Pocket DLog software, click the File menu, select the GPS option under Properties (see 
figure 12), and you can pop up the interface shown in figure 12. 

In the interface shown in figure 12, the Port option from COM1 to COM8 can be selected 
according to the actual connection Port, and the default is COM1; The Baud option has 2400, 4800, 
9600, 14400, 19200, 38400, 57600 and 115K. The setting is the same as that of the Baud in the 
GPS receiver, which normally USES the 9600 band. The Type option has three options, NMEA, 
StarFireRTK and RTK NMEA, which are usually set to NMEA. The Icon option is the display Icon 
for the GPS location at the sampling time; Set the GPS option to On; To ensure that the sampling 
accuracy is within one meter, the DGPS option should be set to On. After all options are set, click 
the OK button. 

After setting the GPS option, click on the New Project under the File menu... Option, click OK 
button to confirm, enter new project setting interface. Enter the name of the new project, click the 
OK button to create a new project. 

 

 
Fig 12  GPS option 

 
Fig 13  GPS settings 

Click New under the Layer menu. Option, pop up the dialog shown in figure 17, and enter the 
Name of the created Layer from the Layer Name option in the dialog box. If you don't select the No 
Attribute option, you need to set the Attribute name, type, size, and precision of the layer to create 
multiple properties. Otherwise, no attributes are added. In the Object Type option, select the layer 
Type, which is mainly point Type, line Type, and surface Type. Set the layer to display the 
color [5]. Click OK button to sample, and figure 18 is the sampling schematic. 

After the sample is completed, connect the PDA and microcomputer, and use Microsoft's 
AciveSync simulator to keep the PDA and microcomputer in sync. Using the Pocket Convert 
software, the collected data can be converted into AutoCad DXF, ESRI shape, MapInfo MIF, XYZ 
Text and Soil Lab DBF files. The data in this paper are all shape files. To run ArcInfo software, 
open the transformed data, grid the data of the collected land, and get the sampling grid, the grid 
map of the block town and 8 town of yulin, jilin province. 

 
Fig 14 set coordinates 

 
Fig 15 Create a new project 
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Fig 16 Create a new layer 

 
Fig 17 Schematic diagram of sampling 

4. Attribute database setup 
According to the sampling grid map, soil samples are taken at the corresponding sampling grid 

points, and the data is saved to in the property database. [6] 
(1) operation function implementation 
The Toolbar (Toolbar) most browsers support 11 kinds of roaming and scaling tools, except that 

the HTML browser does not support Next Extend. Toolbar implements zooming and roaming 
functions for basic map operations. 

Measurement tools are a quick way to Measure the length of a line between two points. As with 
the buffer tool, the measurement tool also requires the default map unit to be defined in the Author 
or by the user using the Set Units tool[7]. When  is used for measuring tools, the length of segment 
length and its total length will be shown simultaneously. Use the Clear Selections tool can remove 
when measuring the painting line, but change the scope of view does not make them disappear. 

There are many options for selecting elements in ArcIMS for Graphical selection tools, such as 
Query Builder, Find Tool, Search Tool, or buffer Tool. In addition, elements can be selected by 
drawing a rectangle, circle, or multilateral line on the graph, and then they are intersected by the 
graph. After the elements are selected, they become part of the selection set, whose property values 
can be listed in table form, or buffer analysis using buffer tools. Clear All Selections tool to remove 
All of the selection. Because the execution of the graphical selection tool varies greatly from client 
to client, this is a great tool for testing which templates to use when creating a site. 

Finding (Find) lookup tools is another way to query spatial databases. The Find tool is a 
commonly used lookup tool that does not require an active layer. In the Java browser, the lookup 
tool can query all of the fields of the layer, and the query is case sensitive. In the HTML browser, 
you can only query the active layer for [8]. Find tools are particularly useful when you're not sure 
that the table is all open or that the user is not familiar with the database operation. At the same time, 
the user can select the selected set to return and roam or scale to the highly selected record. 

Another way to Query a spatial database is to Query for SQL queries by predefined queries. 
Predefined queries are defined in Author by a logical expression with a variable. On the client side, 
the user submits only the value of a variable to the system, which can be queried. Similar to Query 
Builder, users can choose not to download all records if the Query result exceeds 100 records. 
Similarly, you can select a record from the list and scale to the corresponding view to display [9]. 
Although predefined queries limit the ability of users to build complex queries, they can guarantee 
that the query will not fail because it is previously detected. If the user wants more flexible queries, 
use the Query Builder tool. 

The Query Builder Query queries the spatial database and returns the Query results in tabular 
form. The user can create a logical expression through the input or selection method, and the 
expression is committed to the server when the Excute is pressed. If the returned result exceeds 100 
records, the user can choose not to download the selection set for all records. This option may fail 
when the query results exceed the expected elements. It is sometimes difficult to understand this 
phenomenon. When all records are not downloaded, some functions in the menu such as 
highlighting, roaming, zooming, statistics, etc., may fail. 

Advances in Engineering Research, volume 141

1282



The basic statistical functions in the query include the average value, maximum, minimum value, 
standard variance, and sum of all elements or elements. Similarly, the query can be used to map the 
range of maps that are highlighted by highlighting elements. 

Buffer (Buffering feature) buffer analysis is a very important analysis function of GIS. In 
ArcIMS, the interface of the element's buffer analysis is very simple. The user simply selects an 
active layer and USES the query tool to create a select set for the buffer analysis. With the selection 
set, you can use the buffering tool. Enter a buffer distance and select a buffer unit. If it is a Java 
browser, users can also select the elements within the buffer within another topic. This process is a 
little like the choice of the topic in ArcView. Note that when a buffer is analyzed, anything that is 
connected to any part of the buffer becomes part of the selection set. 

(2) ArcIMS implement tile splice technique 
Before Google Maps, all kinds of network map in the technology with the method of traditional 

WebGIS, using Java Applet, SVG, dynamically generated map image, and Google Maps USES 
Ajax and tiles splicing scheme to build the new mode of network map has been widely recognized. 

To build a Google Maps style web map, you first need to have a Google map-like JS library as a 
client. The second is how to connect the client to ArcIMS, how to cache images, and so on[10]. 

In the HTML file, the JS code for creating a map is as follows: 
function IMSMapType() { 
    MapType.apply(this); 
    this.getSrc = function(level, row, column) { 
        return "arcims.asp?z="+level+"&x="+column+"&y="+row 
    } 
} 
MapModel.mapTypes = new Array(new IMSMapType()); 
MapModel.maxZoomLevel=10  
This code creates a map type, you can also create a variety of types of Maps (similar to Google 

Maps), including getSrc function defines how to return the picture method, there are three 
parameters: scaling, horizontal position and vertical position [11]. In the library of MapEasy, images 
of different scales are spliced in the same subscript as in a two-dimensional array. 

In arcims. Asp, the main program flow shown in figure 18, first of all, according to the location 
of the image parameters, constructing images, and then judge whether there is, if it exists, is 
returned, otherwise call arcims rendering and save the image. The return images do not use 
redirection to the image, but in the way they write the data stream. 

(3) implementation of fertilization decision 
Assumptions: 
Sf: fertilizing amount; Cl: corn target yield; Xs: the absorption component of corn grain for 

every 100kg of corn; CD: soil nutrient determination value; 
Ys: effective nutrient conversion coefficient of soil; Hl: nutrient content of fertilizer; Ly: 

fertilizer rate utilization rate, nutrient balance method fertilization model is: 

                                 (1) 
The mathematical model of fertilization of phosphate fertilizer in nongan county was calculated 

as an example (the content of P2O5 in the diammonium of diammonium was 46% 
Corn target yield*0.007-0.3* Soil nutrient content*Soil 

effective nutrient conversion coefficient 
Fertilization of phosphate fertilizer=                               

 0.46*Fertilizer efficiency 
                               

(4) implementation of spraying decision-making function 
Assumptions:To indicate the grade of weed density; Indicates the density of weed, unit is 

strain/meter 2; The dosage was diluted 200 times.According to the classification of weed density, 
the formula is as follows: 

lyhl
yscdxsclsf

×
×−×

=
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Different weed density levels were applied to the corresponding dosage, and the model was as 
follows:  
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yl              (3) 

(5) spatial fuzzy algorithm implementation 
The fuzzy equivalence matrix is based on the fuzzy equivalent matrix clustering algorithm, 

which USES the detailed design tool - problem analysis diagram (PAD) to describe the algorithm. 
FCM algorithm implementation is based on the principle of FCM algorithm, which USES the 
detailed design tool - problem analysis diagram (PAD) to describe its algorithm. The analytic 
hierarchy process (ahp) is based on the principle of analytic hierarchy process (ahp), which USES 
the detailed design tool, problem analysis diagram (PAD), to describe the algorithm of [12]. 

5. Conclusion 
Introduces the WebGIS system in this paper, spatial data mining and visualization of data mining 

method, the integrated application of WebGIS, expert system, decision support system and visual 
space fuzzy data mining technology, developed a "VSDM and WebGIS based intelligent 
decision-making system of corn". The main innovation points have the following aspects: 

(1) the WebGIS, expert system, decision support system and visual spatial fuzzy data mining 
technology is applied to the system implementation, so as to achieve the management of spatial data, 
analysis, and decision making. 

(2) a spatial weighted fuzzy dynamic clustering algorithm is proposed based on the hierarchical 
analysis method. The results show that the classification results of the algorithm can be more 
objective and accurate. Main performance:The algorithm can distinguish noise effectively. The 
algorithm can fully consider the imbalance between each property. 

By introducing F - distribution in the algorithm, the optimal threshold value is obtained and the 
optimal threshold is obtained by using the optimal threshold of the optimal classification. 

(3) the 2 mentioned in algorithm applied in the variable fertilization to improve the 
comprehensive evaluation on the spatial heterogeneity of soil nutrients, has been in the same plot 
after years of continuous variable fertilizer can improve the spatial heterogeneity of soil nutrients to 
the conclusion that the "journal of agricultural engineering review experts, evaluation for" on the 
thinking method has certain innovation value, the overall high academic value and research 
significance ". 

(4) combining entropy weight method in information theory, this paper proposes a new 
algorithm for FCM algorithm based on entropy weight method. The entropy weight method is the 
difference between the data itself and the actual distribution of data. In addition, entropy weight 
method does not need to score and input data, which reduces the influence of subjective factors, and 
has better automation and intelligence. The results are higher than the unweighted FCM algorithm 
by analyzing both the Iris and Wine data sets. 

(5) realize the visualization of spatial data mining results in two ways: one is realized by using 
star coordinates; The other is based on GIS. Visual results can help us to analyze and make 
decisions about data. 

(6) according to the nutrient content of the community, the fertilization decision was realized, 
and the fertilization rate of each community was obtained. Based on this, the application of 
fertilization recipe is generated to provide the data basis for the operation of the variable fertilizer 
machine. 

Currently, the function of the theoretical research has been completed, the algorithm of each part 
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is programming implementation, and as long as a little modification, the algorithm can be applied to 
other areas, the portability is good. However, the weighted FCM algorithm has not been integrated 
into the system yet. 
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